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MOSTCOOL

(Multi-Objective Simulation Tool for Cooling “»
Optimization and Operational Longevity) COOLERCHIPS

F.P. McCluskey, Univ. of Maryland, College Park
Team Members: NREL, LBNL, Univ. of Arkansas, Trane

Project Vision

* To develop an integrated co-simulation software toolset that can
be used to optimize the design of data centers, including their
data, power and thermal management systems for lower cooling
energy demand, lower CO2 footprint, and lower cost, while
maintaining high reliability and availability
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Total Project Cost: EEEALY
Length 36 mo.

COOLERCHIPS Kickoff .
Meeting
October 18 & 19, 2023

To facilitate the adoption of this tool to achieve transformational
and disruptive design advances, first by Track A and B performers
and then by the larger data center design community.




COOLERCHIPS Project Overview: MOSTCOOL Fed. fonding: [T

Length 36 mo.
University of Maryland College Park. MD PRIME Thermal, Reliability, and Cost Analysis
National Renewable Energy Lab Golden, CO Software Integration/Development, Reliability
Lawrence Berkeley Nat'l Lab Berkeley, CA Building Scale Thermal, Energy, and CO2 Footprint Modeling
University of Arkansas Fayetteville, AR Module and Device Reliability
Trane Davidson, NC Building Models, Software Validation, Market Analysis

Integrate and enhance existing simulation models into a multi-objective co-
simulation tool that when adopted will achieve transformational and
disruptive data center designs that dramatically reduce data center cost,
energy use, and CO2 footprint while maintaining high reliability/availability.

Program Metric | State of the Art

Co-simulation Individual Multi-objective optimization with
simulations user defined value functions
Interaction Model No interactions Second-order interactions

Tooluse by data  Use of individual  Open source tool for data center
center industry proprietary tools  industry wide use
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R el * Convert existing models into software with an emphasis on usability
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Software Tool Capability Overview

Open source software providing seamless multi-physics simulation of data center scale thermal profiles,
energy usage, CO2 footprint, reliability, availability, and cost through a user-friendly GUI.

« Will include a base library of common cooling components

| « Will allow modeled data center to be placed in any climate zone

« Will allow user to specify average/hourly climate conditions

« Common system model used for energy, reliability and cost analysis

« Users build custom component modules to interface with system model

» Estimates operational CO2 emissions using national average or local carbon
emission factors

« Multiple releases with an aggressive time scale for improvement

Thermal Modeling

Availability Modeling Cost Modeling

Predict availability to within < 1% + Path to calculate IRR and

Availability determined using reliability number of years to payback.
block diagrams, Markov chain analysis, « Will require data on cost per part,
and Fault Tree Analysis. operational energy cost projection,

Calculate rack and module
temperature to within +/- 5°C

High fidelity modeling tools used to
capture complex physics in the novel
single-/two-phase cold plates
developed by Topic A & B teams

Reduced order modeling tools to model
server & rack level cooling.

« Based on PoF models for degradation of Inflation assumptions.
electronic and cooling systems requiring » Estimate both CAPEX and OPEX
test data inputs from performers. and allow tradeoffs such as costs

« FMEA score for component interactions of lower performance vs. costs of
replacement/repair.
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Thermal Modeling

The thermal profiles will be able to calculat

Level 1: Device Modeling

Develop high fidelity modeling tools to
capture complex physics in the novel
single-/two-phase cold plates developed
by teams in Technical categories A & B.

e Initial  version  release includes
OpenFOAM based CFD solver with
GUI interface followed by a PINN -
PDE solver.

* Release demos for OpenFOAM solver
and PINN solver for users.

* Create a data pipeline for data flow to
higher level 2 and level 3 modeling.
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Level 2: Server/Rack modeling

Develop reduced order modeling tools
to model server & rack level cooling.

» Make use of empirical relations and
existing data to model air cooling on
other components in a server and rack.

» Make use of data from the high-fidelity
simulations in level 1 to mimic the
novel heatsink to run the reduced order
modeling.

e the temperature of the racks and modules to within +/- 5°C

Level 3: Data center modeling

» Make use of data from server/rack level
as input conditions to data center model
(e.g. pressure drop across server and
power generation).

 Simplification of racks and servers
based on level 3 modeling to reduce the
modeling complexity and ensure faster
and accurate modeling.




EnergyPlus — Building Energy/C02 Modeling

The energy usage profiles will be able to calculate energy usage to within <2% of IT load e

Inputs EnergyPlus model Outputs

Building Characteristics: . — Energy: chillers, fans,
Envglope, HVAC, e s pumps, lighting, DC, waste
lighting, DC load (0 orFrion oy T Dd o Snen heat recovery
Operation/use: HVAC e o — e A Peak demand
schedule, setpoint, e o Operational CO2/GHG
occupant schedules b q A i Utility costs
oflo Supply Air N || )
Utility rates R o Indoor environmental
GHG emission factors Ecic o Ao e S L conditions: temperature,
Weather data Pt o - =) L humidity
Sy Tom I . =Ml L
Retum Tem / = = |
Retun Tem 7= = =| -
QA { = 2= = ? i @)
I 1 I Hot Air : : Cold
o ) =l )

Energy — Accounts for pumping power of the liquid through the cooling system plus room air conditioning
CO2 Footprint — Based on energy source and likely linear with energy. Expressed in kg CO2/kWh
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PoF Reliability Modeling

— Identifying and modeling dominant device and cooling system failure mechanisms

— Estimating time to failure for each element failing by each failure mechanism

— Using fault tree analysis/Markov chains for component inter-dependencies

— Using probabilistic mathematical approaches to combine independent distributions for identical
or non-identical parts failing due to identical or non-identical mechanisms
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Availability Modeling

The availability software will be able to predict availability to within < 1%

* Construct a fault tree diagram of all components and possible failure
modes to determine what combinations cause system downtime.

wl

 Create a series/parallel reliability block diagram (RBD) of the system - { ]

* For each component, conduct a Monte Carlo analysis to determine a
distribution of failure times based on the mechanisms causing ‘ '. '! A ’. ~D ’!
earliest failures. O r

* For each RBD, run a series of Monte Carlo simulations, inserting a over

!

random failure time for each component within that component’s
failure distribution.

* Combine the failure times for each RBD, accounting for redundant
components, where multiple systems would have to fail/require
maintenance simultaneously for the system to go down. _

* For each Monte Carlo iteration of an RBD that lasted one year ==
without failure, there would be no downtime. For each iteration that
failed, the length of downtime would be calculated.

* From the sum of all the downtimes for all the runs for all the RBDs, a
system availability of total uptime/total time) would be generated.
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Cost Modeling

Determine the total cost of ownership of the data center including its power and thermal management
systems, and perform maintenance planning tradeoffs based on the forecasted RULs of critical equipment.

Thermal modeling \

Reliability modeling

Prognostics

Degradation of Data | DR 6 Cooliz Energy Utilization Impact
Center Equipment Equipment
A\ 4
N .
RUL* of thg Data Center | | RUL* of .the Cooling CO2 Footprint Impact
Equipment Equipment
i X u v Data Center
nvironment that includes
preventative maintenance Predictive and Corrective Pe(r:f;])ar:;aer;ce
that may modify RUL, Maintenance
energy utilization and CO2 l
footprint predictions Revenue
Loss/Gained
A 4 A 4
Cost of Ownership = CAPEX + OPEX 4 | Facilities Abatement
g = .. N
CQIrpPQ-EC *RUL = Remaining Unit Life
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Cost Modeling — System Life-Cycle Cost Outcome Example

Example system payback associated with predictive system health/maintenance management
« Stochastic return on investment (ROI) analysis associated with the implementation of prognostics and
health management (PHM) in an electronic display unit in a fleet of aircraft

Sandel ST3400 TAWS/RMI
Engtr_onicDiquy Unit
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Example ROI (relative to unscheduled
corrective maintenance) of one instance of the
unit managed with PHM over its 20 year
installation life

There are 502 aircraft in the fleet, each one
has a unique maintenance history, this is the
ROI experienced by one aircraft in the fleet

0.4

0.1

-0.2

-0.5

-0.8

Return on Investment (ROI)

First
maintenance
event ] T \
T BREAKEVEN
\ w Small ROl increase (at \

3 maintenance event),
which coincides with
inventory replenishment.
PHM saves money on
maintenance events,
BUT buys more
expensive spares (that
include PHM recurring

PHM missed this
failure, therefore, it
was resolved as an
unscheduled
corrective
maintenance event

| _%7‘—‘— costs)
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Annual costs of managing  Time (years)
the system with PHM

Mean Return on Investment (ROI)

ROI (relative to unscheduled corrective maintenance)
at the end of 20 years for 502 instances of the unit

Probabi I ity !teaanr;;rg giwanon: 0.4
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Co-Simulation Platform Selection

« Co-Simulation Platform actively coordinates shared simulation time with robust data exchange and supports multi-rate (time step) systems.
« Landscaped five co-simulation platforms. Performed detailed, multi-platform assessment of openBuildNet, HELICS and Mosaik.

to shape network traffic * No MPI Support

* HELICS selected as co-simulation platform (core) Criteria openBuildNet HELICS Mosaik

o Multi-platform (Windows, Linux, HPC Linux-based clusters) Simulation » Through any supported |+ Through any supported * Only through Python.

setup programing language. programming language. » Moderately complex

« Supports physics and controller model development environments * Simple and less * Moderately simple and and with some

. tools (C. C++. Pvth Modeli Matlab. Juli overhead. less overhead. overhead.
using many common (oois ( ’ , Python, Modelica, Matlab, Ju Ia) « Inline configuration. * Separate and inline « Inline configuration.

. : : : : « Uniform interface for all | configurations. « Interface varies with
Established _contacts for collaboration with DOE National Labs supported o Ui friiertoase o ol programming language
for HELICS improvements tools/languages. supported / tool.

tools/languages.
User Interface (software input parameters and outputs) Synchroniz'n |+ Global Clock + Parallel and iterative * Time, event and hybrid
~ The actual implementation of Arbitration - Explicit ordering - Implicit and parallel - Explicit ordering
optimizer depends on use cases

........... VI = = === memmem = m Data » Connection setup * Reliable connection setup [+ Reliable when using

| HELICS Federation [CvRI i throughput delays. and data transfer. inbuilt network sockets.
: i and reliability |+ Intermittent packet * ZMQ Support » ZMQ extension does

: Control X loss. * MPI Support not support

: Models i * Message filters available handshaking.

| i

! i

Simulation » Multi-rate support. » Multi-rate support.  Multi-rate support.

Publication/ management |« Distributed nodes. * Distributed nodes. + Distributed nodes.

subscription * Node drop * Node drop handling. * Node drop handling

7 identification. (only with inbuilt
protocol).
Additional None * Single point simulation + Single point simulation
framework control. control.
i -~ j i ma utilities » Data coIIectiqn tool. « Data collection tool.
‘ ' l ‘ L + Data generation tool.
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Task Outline & Technical Objectives

> The software will provide seamless multi-physics simulation of data center scale s i [ Tamisons beinio awea
Title

thermal prOfiIeS, energy usage, Coz fOOtprint, reliability; availability; and COSt- M11 Go/No-Go:Refine | Go-No/Go Milestone: Refine tasks and milestones for the work 1

tasks & milestones | plan (if applicable)

— Thermal profiles calculate the temperature of the racks and modules to within +/- 5°C. s o ves | socment modsing needs or the sommon cooing spproachesior |1

Identified Team A and B teams. Qutline the structure of the toolset.

— The energy usage profiles calculate energy usage to within <2% of IT load ML3 | MaretSuvey | Document elevat SOTA sftware modelingpackgesfoolsand |1
. ope . . . o . . . ner, ocde ow tha e Energy sortware can modae| e Lf ica
— The availability software will be able to predict availability to within < 1% B o N il b

ML.S Initial Cost Analysis | Baseline cost scenario for typical data rack or other reference. 2

> Multi-objective optimization with value functions set by user. VRS [Meleaseno: | RELEASEL0:Reless of the Energy and Thermal Modelng Sofuare | 2

Model Release

> Second order interactions, such as between thermal and reliability, between I e

. ope . ML1.8 Cooler Reliability Physics of Failure Models Developed for Cooling Component 3
availability and cost, and between energy usage and CO2 footprint Retabiy
ML1.9 Guidelines Provide Testing and Design Guidelines 3
ML.10 Release 2.0: Initial | RELEASE 2.0: Initial Release of the Integrated Tool Containing 4
FIVE REL EAS ES Integrated Tool Thermal, Energy, Reliability, Availability, and Cost Tools.
Release
ML.11 Building Scale Meodels Extended to Address Building Scale Assessments 5
Model
m Release contalns Tlmlng M1.12 Marketing Plan Initial Commercialization and Adoption Plan Developed 5
ML.13 Graphical User Initial User Interfaces Modified Based on Performer Feedback and 6
Interface GUI Enhanced for Integrated Software Toolset at Building Scale
Thermal Energy; COSt Coz Inltlal Release M1.14 Go/No-Go: User Adoption and Successful Modeling by a Plurality of A and B 6
F t t M d I Adoption Teams
00 p rl n O e S M2.1 Release 3.0: Final RELEASE 3.0: Release for Full Design Review of Performance Targets | 7
Release for Teams | (includes Integrated Software with Updated Models for Thermal,
e 22 o e[l A&B Energy, Reliability, Availability, and Cost).
4 200 Rellablllty; Avallabl | Ity MOdeIS Befo re Q6 RaCk Demo M2.2 Optimization and Flexible optimization value function definition software developed. | 8
Interaction Inclusion of second order interactions between model elements.
. . M2.3 GUI for External Full GUI and Documentation developed for Release to External Data | 9
7 3.0 Building Scale Models Before Q9 Full Demo Release Center Community
M2.4 Release 4.0: Beta RELEASE 4.0: Beta Release to Public and Hosting of Workshops for 10
Release to Public Software Adoption/Feedback by Data Center Community
1 1 M2.5 Post-program Post-program plan for commercializing the software tool 10
10 4.0 Beta Release For Public Review o Bt
M2.6 Final Software Complete data operations optimization and paralleling. 11
. Revisions
1 2 5.0 Flnal Release End Of Prog ram M2.7 Release 5.0: Final RELEASE 5.0: Final Public Release 12

Public Release
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Challenges and Risks

m Technical Risks Explanation/Mitigation

Risk Status

T1 Insufficient or inadequate input . Reliability needs validated model constants, materials
information for the modeling. of construction, design dimensions, and life cycle loads.
Almost (guideline for tests and getting info)
Certain . CO, needs database of Mt per process
. Thermal and energy need power dissipations and
_ cooling parameters (COP, heat flux)
Likely »  Availability needs redundancy and reliability input
. Cost needs availability, repair, and replacement cost
©
o T2 Interoperability of the disparate All programs need to get input from a common user interface
= Moderate . . .
= modeling software packages. and output that is accessible by HELICS.
=
| T3 Inappropriate Basis or Weighting Optimization function is available to the performers to set
Unlikely Factors for Optimization the optimization criteria, Cost, CO2 Footprint, Availability.
T4 Models not sufficiently accurate Many different scenarios for cooling. Work with Track A and
with required run time or flexible B performers to convert their complex FEA/CFD models to
fers for disparate cooling solutions high fidelity surrogate models for thermal, reliability, etc.
m Adoption Risks Explanation/MItigation
Insignificant|  Minor Moderate Major |Catastrophic Not available when needed by Initial integration of currently available software with rapid
performers improvement cycles and a carefully timed release schedule.
Consequences A2 Lack of knowledge of performers’ Biweekly/Monthly Communication with Topic A and B
modeling and analysis preferences performers starting with the one-on-one meetings today.
A3 Difficult to use (poor interface) Several releases to accommodate feedback on user
effectiveness from the Topic A and B performers
A4 Commercial options chosen instead  Extensive benchmarking of existing software and its
‘i' Ij‘i of limitations to showcase how this software is superior
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Communication Plan:

Three-level Organizational Structure

Inner circle — Meets Online Biweekly
» Core project team
* Representatives from Track A and B performers

Second level — Meets Online Monthly
» Corporations from the data center industry that have shown
Interest (i.e. Intel, AEI, and SmithGroup) in our work,

Third level — Meets Online Quarterly

» Advisory board consisting of a diverse group of educational
Institutions, corporations, and industry professional groups in
the wider data center community

Semi-annual in-person meetings
» Entire three-level membership and DOE representatives.
» Coincide with software releases.

QrpPQ-@
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Educational Institutions

SMITHGROUP

COOLERCHIPS
Technology
A &B Teams

== Affiliated
il =l Engineers

Industry Groups




Technology-to-Market Approach

v

This proposal team includes the lead developers of OpenStudio and EnergyPlus.
— Proven track record of success bringing open source software technologies to market.
— Among DOE’s most downloaded software programs
—  Will borrow approaches and proven channels used for OpenStudio and EnergyPlus, including GitHub

NREL has an outstanding command of industry best practices for software development
— CI/CD and integrated, comprehensive software testing.
— Automated extended-validation code signing workflow to ensure cyber-security and quality requirements.
— OpenStudio and EnergyPlus software incorporated by companies like Trane, Carrier, and Autodesk

NREL has strong credentials in partnering with many universities,
— OpenStudio and EnergyPlus are intertwined into multiple curricula.
— Network of partnerships with university programs dedicated to enhancing buildings, including data centers.
— Existing channels can be leveraged for introducing COOLERCHIPS software

The proposal team includes Trane employees who are responsible for developing Trane's industry-leading TRACE software for
designing and building heating, ventilation, and air conditioning (HVAC) systems.
— Trane's has track record of leveraging open-source software for commercial products and offerings
— Trane will also bring its business acumen and market experience to advise the larger proposal team to ensure the
COOLERCHIPS software is best positioned to meet the industry’s data center design needs.

With Intel representing computer chip manufacturers and SmithGroup and AEIl representing the data center design and
construction industry, the proposal team will receive insightful advice on ensuring COOLERCHIPS software has features and
functionalities most needed by corresponding industry sectors.

OpenStudio and/or EnergyPlus are included in many building design and construction workflows, COOLERCHIPS software will
be more easily incorporated into these workflows, maximizing its impact.

QrpQa-e@e
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We are looking forward to our one-on-one discussions with each team this afternoon.

Please bring your answers and thoughts regarding the questionnaire provided before this workshop.

Q&A

\.il b| .D\.i" C

https://arpa-e.energy.gov

U.S. DEPARTMENT OF

'ENERGY
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